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BAB IV 

PEMBAHASAN 

 

4.1 Data Teknik Proyek 

Berikut ini adalah data-data teknik proyek pembangunan pembangunan Kantor PT. 

Bank Muamalat Tbk Cabang Malang: 

a. Nama Proyek   : Proyek  Pembangunan Gedung PT. Bank  

Muamalat Tbk Cabang Malang. 

b. No.SPK   : 037/BMI/VII/2013. Tanggal : 29 Juli 2013 

c. IMB No   : No 640/2900/35.73.407/2013 

d. Pelaksana   : PT. Galih Medan Persada (GMP) Jakarta 

e. Waktu Pelaksanaan  : 270 Hari Kalender 

f. Masa Pemeliharaan  : 180 Hari Kalender 

g. Total Waktu Pelaksanaan : 450 Hari Kalender 

h. Nilai Kontrak   : Rp.3.648.000.000,- 

i. Konsultan Perencana  : PT. RDR Consultant Jakarta 

j. Konsultan Pengawas  : PT. Puri Ratna Kreasi Jakarta 

Secara umum Proyek Pembangunan Gedung PT. Bank Muamalat Tbk Cabang Malang 

memiliki banyak aktivitas dengan volume yang berbeda-beda. Berdasarkan data proyek yang 

diterima tentang pengalokasian sumber daya, tingkat fluktuasi sumber daya tergolong tinggi. 

Hal ini terlihat dari bentuk dan tingkat diagram batangnya. Pada proyek ini tidak semua 

aktivitas dapat dileveling, karena Metode Burgess hanya dapat dilakukan pada aktivitas non 

kritis yang memiliki total float (waktu bebas). Pada penelitian ini sumber daya yang dileveling 

adalah tukang besi. 

Pekerjaan yang dileveling adalah pekerjaan pembesian yang membutuhkan tukang besi 

sebagai sumber dayanya, walaupun suatu pekerjaan memiliki total float namun tidak 

membutuhkan tukang besi maka pekerjaan itu tidak perlu dileveling. Total float (waktu bebas) 

menunjukan jumlah waktu yang diperkenankan suatu kegiatan boleh ditunda tanpa 

mempengaruhi jadwal penyelesaian. Ini diartikan dengan menunda suatu pekerjaan sesuai 

dengan total float yang tersedia dalam pekerjaan tersebut, jadwal awal hingga berakhirnya 

proyek tidak akan terpengaruh. Namun, memungkinan untuk berubah jadwal pada aktivitas 

yang mempunyai ketergantungan, sehingga mempengaruhi jadwal awal dan berakhirnya suatu 

pekerjaan yang memiliki ketergantungan. 
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4.2 Pengolahan Data dengan Software Primavera Project Planner 

Langkah-langkah untuk melakukan pengolahan data proyek dengan software 

primavera project planner adalah sebagai berikut: 

1. Menentukan kebutuhan sumber daya 

2. Menentukan input data 

3. Membuat proyek baru dengan menggunakan software Primavera Project Planner 6.0.  

4. Memasukkan data ke software Primavera Project Planner 6.0. 

5. Membuat jaringan kerja. 

 

4.2.1 Menentukan Kebutuhan Sumber Daya 

Kebutuhan sumber daya yang digunakan dalam penelitian ini adalah data dari laporan 

mingguan yang didapat dari Proyek Pembangunan Gedung PT. Bank Muamalat Tbk Cabang 

Malang, yang di dalamnya terdapat laporan harian dalam setiap minggunya. Untuk penggunaan 

sumber daya setiap minggu didapat dari kebutuhan rata-rata jumlah sumber daya setiap harinya 

dalam setiap minggu. Untuk jadwal penggunaan tenaga kerja yang tersedia di proyek setiap 

minggunya dapat dilihat pada Tabel 4.1. Untuk detail laporan mingguan yang didapat dari 

Proyek Pembangunan Kantor PT. Bank Muamalat Tbk Cabang Malang dapat dilihat dalam 

Lampiran 1. 

Tabel 4.1 Jadwal Penggunaan Tenaga Kerja Setiap Minggu 

 

 

 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28

Manager proyek 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 28

Manager lapangan 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 28

Engineer lapangan 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 28

Juru gambar - - - - - - - - - - - - - - - - - - 1 - - - - - - - - 1 2

Administrasi 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 84

Operator 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 28

Kepala pelaksana 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 28

Mandor 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 28

Tukang kayu - - - - 1 10 10 - - - - - 10 10 7 7 7 12 12 12 12 5 2 - 2 2 6 8 135

Pekerja kayu - - - - - - - - - - - - - - - - - - - - - - - - - - - - 0

Tukang batu 5 6 10 11 5 - - 10 10 7 10 11 - - - - - - - - - - - - - - - - 85

Pekerja batu - - - - - - - - - - - - - - - - - - - - - - - 14 - - - - 14

Tukang besi 0 5 5 6 5 10 10 10 10 10 10 6 10 10 5 5 5 5 5 5 5 5 1 0 0 0 0 0 148

Pekerja besi - - - - - - - - - - - - - - - - - - - - - - - - - - - - 0

Surveyor 1 1 - - - - - - - - - - - - - - - - - - - - - - - - - - 2

Pekerja 10 10 10 10 20 25 25 25 25 25 25 10 25 25 15 15 15 15 15 15 15 15 7 2 2 2 18 42 463

Jumlah tenaga kerja 25 31 34 36 40 54 54 54 54 51 54 36 54 54 36 36 36 41 42 41 41 34 19 25 13 13 33 60 1101

Tenaga kerja ( orang )
Minggu ke

Jumlah
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4.2.2 Menentukan Input Data 

Data-data yang dimasukkan untuk melakukan penjadwalan pada software Primavera 

Project Planner 6.0 adalah: 

a. Aktivitas kegiatan 

b. Durasi setiap kegiatan 

c. Jumlah sumber daya setiap minggunya 

Dari input data di atas dilakukan running program yaitu menggunakan software 

Primavera Project Planner 6.0 yang akan menghasilkan penjadwalan yang siap untuk 

dilakukan leveling. 

 

4.2.3 Membuat Proyek Baru dengan Software Primavera Project Planner 6.0 

Langkah-langkah membuat proyek baru ke Software Primavera Project Planner 6.0 

adalah sebagai berikut: 

1. Membuat Project Baru 

a. Pilih menu File > New 

b. Selanjutnya akan ditampilkan Create a New Project Wizard, selanjutnya akan 

terlihat gambar seperti pada Gambar 4.1. 

 

Gambar 4.1 Select EPS 

c. Pada Kotak dialog pilih Enterprise Project Structure (EPS) 

d. Klik Next, dan akan tampil Project Name seperti pada Gambar 4.2, dan isi sesuai 

kebutuhan. 
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Gambar 4.2 Project Name 

e. Klik Next, dan akan tampil Project Start and End Dates seperti pada Gambar 

4.3, dan isi sesuai kebutuhan. 

 

Gambar 4.3 Project Start and End Dates 

f. Klik Next, dan akan tampil Reponsible Manager seperti pada Gambar 4.4, dan isi 

sesuai kebutuhan 
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Gambar 4.4 Responsible Manager 

g. Klik Next, dan akan tampil Assignment Rate Type seperti pada Gambar 4.5, dan 

isi sesuai kebutuhan. 

 

Gambar 4.5 Assignment Rate Type   

h. Klik Next, dan akan tampil Project Architect seperti pada Gambar 4.6, dan isi 

sesuai kebutuhan. 
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Gambar 4.6 Project Architect   

i. Klik Next, dan akan tampil tampilan akhir dari wizard yaitu konfirmasi 

Congratulation seperti pada Gambar 4.7. 

 

Gambar 4.7 Congratulation   

j. Selanjutkan akan tampil dari perencanaan proyek baru yang telah anda buat seperti 

pada Gambar 4.8. 
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Gambar 4.8 Perencanaan Proyek Baru 

2. Mengatur Kalender Proyek 

a. Klik menu Enterprise > Calendars 

b. Selanjutnya akan terlihat tampilan seperti pada Gambar 4.9. 

 

Gambar 4.9 Calendars 

c. Pilih Calendars yang akan menjadi Default Calendars sesuai kebutuhan. 

d. Klik Close untuk menutup kotak dialog  

Setelah proyek baru sudah dibuat dalam software Primavera Project Planner 6.0, 

langkah selanjutnya adalah memasukkan data-data yang digunakan untuk proses pengolahan 

data. 
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4.2.4 Memasukan Data ke Software Primavera Project Planner 6.0 

Langkah-langkah memasukan data ke Software Primavera Project Planner 6.0 adalah 

sebagai berikut: 

1. Memasukkan Activity pada Chart Bar 

a. Klik menu Project > Activity 

b. Klik menu Add 

c. Selanjutnya akan terlihat tampilan seperti pada Gambar 4.10. 

 

Gambar 4.10 Memasukkan Activity pada Chart Bar 

d. Ketik nama kegiatan proyek pada kolom Activity Name, isi sesuai kebutuhan. 

2. Memasukkan durasi setiap pekerjaan 

a. Arahkan kursor pada kolom Original Duration dan klik ganda, Selanjutnya akan 

terlihat tampilan seperti pada Gambar 4.11. 

 
Gambar 4.11 Menambahkan Durasi Pekerjaan 
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b. Ketik lamanya waktu yang dibutuhkan untuk menyelesaikan pekerjaan. 

c. Ulangi langkah 1 dan 2 hingga semua kegiatan dan durasi kegiatan selesai di-input. 

d. Selanjutnya akan terlihat tampilan seperti pada Gambar 4.12. 

 

Gambar 4.12  Penjadwalan Data Pekerjaan 

3. Memasukan Sumber Daya ke Dalam Kegiatan 

a. Pilih menu Enterprise > Resources. 

b. Klik tombol Add 

c. Selanjutnya akan terlihat tampilan Form Resources seperti pada Gambar 4.13. 

 

Gambar 4.13 Form Resources 

d. Isi Resources ID, Resource Name sesuai kebutuhan. 

e. Klik menu Project > Activity 

f. Klik Tab Resources 
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g. Klik tombol Add Resources 

h. Selanjutnya akan terlihat tampilan seperti pada Gambar 4.14. 

 

Gambar 4.14 Add Resources 

i. Pilih sumber daya yang telah ditentukan sebelumnya, kemudian klik dua kali. 

j. Selanjutnya akan terlihat tampilan seperti pada Gambar 4.15.. 

 

Gambar 4.15 Menambahkan Resources Pada Pekerjaan 

k. Untuk mengisi jumlah sumber daya yang dibutuhkan pada setiap pekerjaan, pada 

kolom Budgeted Units, isi jumlah pekerjaan pada setiap pekerjaan seperti pada 

Gambar 4.16. 
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Gambar 4.16 Jumlah Sumber Daya yang Dibutuhkan 

l. Ulangi langkah-langkah di atas hingga semua data telah di-input. 

Data penjadwalan yang telah dibuat dalam software Primavera Project Planner 6.0, 

diperoleh data berupa diagram balok saja tetapi belum diketahui hubungan ketergantungan 

setiap pekerjaan satu dengan yang lainnya. Untuk itu diperlukan jaringan antar kegiatan. 

Jaringan yang dibuat dengan batasan hubungan yang paling memungkinkan dalam 

pelaksanaannya. 

 

4.2.5 Membuat Jaringan Kerja 

Jaringan kerja dibuat sedemikian rupa, tetapi tidak mengubah posisi kegiatan atau 

jadwal pelaksanaan kegiatan yang kita dapat dari penjadwalan proyek itu sendiri. Atau dengan 

kata lain awal dan akhir pelaksanaan kegiatan pada penjadwalan yang kita buat sama dengan 

penjadwalan asli dati proyek tersebut. Langkah-langkah untuk membuat jaringan kerja adalah 

sebagai berikut: 

1. Menentukan Relationship 

a. Arahkan kursor pada suatu pekerjaan, klik tab Relationship 

b. Selanjutnya akan terlihat tampilan seperti pada Gambar 4.17. 
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Gambar 4.17 Memilih Jenis Pekerjaan 

c. Pada kelompok Prodecessors  klik tombol Assign 

d. Selanjutnya akan terlihat tampilan seperti pada Gambar 4.18. 

 

Gambar 4.18 Assign Prodecessors 

e. Pilih pekerjaan yang berhubungan dan klik Assign. 

f. Selanjutnya akan terlihat tampilan seperti pada Gambar 4.19. 
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Gambar 4.19 Hubungan Antar Pekerjaan  

g. Pilih hubungan antara pekerjaan satu dengan pekerjaan yang kita Assign. 

h. Ulangi langkah-langkah di atas hingga semua hubungan antar pekerjaan selesai. 

2. Penjadwalan Data Pekerjaan 

a. Klik menu Tools > Schedule. 

b. Selanjutnya akan terlihat tampilan seperti pada Gambar 4.20. 

 

Gambar 4.20 Schedule 

c. Klik tobol Options 

d. Selanjutnya akan terlihat tampilan seperti pada Gambar 4.16. 
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Gambar 4.21 Schedule Options 

e. Aktifkan Schedule automatically when a change affects dates 

f. Dengan memilih penjadwalan secara otomatis, maka tidak perlu melakukan 

penjadwalan pada masing-masing pekerjaan. 

g. Klik tombol Close untuk menutup kotak dialog 

h. Kemudian pada kotak dialog Schedule klik tombol Schedule untuk memulai 

penjadwalan proyek 

i. Selanjutnya akan terlihat tampilan seperti pada Gambar 4.22. 

Gambar 4.22 Hasil Schedulue 
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Dari jaringan kerja yang telah kita buat, kita dapat membuat lintasan kritis dan 

non kritis. Dimana akan terlihat kegiatan-kegiatan mana saja yang memiliki float, yang 

nantinya akan dilakukan penundaan. Untuk melihat hasil penjadwalan menggunakan 

software Primavera Project Planner 6.0 lebih lengkapnya dapat dilihat pada Lampiran 

2. 

 

4.3 Membuat Lintasan Kritis dan Non Kritis 

Lintasan kritis dan non kritis yang telah kita buat kemudian ditabelkan untuk 

mempermudah kita dalam menentukan kegiatan-kegiatan yang akan kita tunda untuk 

melakukan proses leveling. 

4.3.1 Lintasan Kritis 

Tabel 4.2 Hasil Lintasan Kritis Primavera Project Planner 

ID Pekerjaan Kegiatan 
Mulai Akhir Float 

A1000 Galian tanah pondasi tahap I 28-Jul-13 3-Aug-13 0 

A1010 Galian tanah pondasi tahap II 14-Sep-13 19-Aug-13 0 

A1020 Galian tanah pondasi tahap III 29-Sep-13 5-Oct-13 0 

A1030 Pasir urug bawah pondasi tahap I 8-Sep-13 21-Sep-13 0 

A1040 Pasir urug bawah pondasi tahap II 29-Sep-13 5-Oct-13 0 

A1050 Lantai kerja di bawah pondasi tahap I 8-Sep-13 21-Sep-13 0 

A1060 Lantai kerja di bawah pondasi tahap II 29-Sep-13 5-Oct-13 0 

A1070 Pasir urug di bawah sloof 22-Sep-13 28-Sep-13 0 

A1080 Lantai kerja di bawah sloof 22-Sep-13 28-Sep-13 0 

A1090 Aanstamping 29-Sep-13 5-Oct-13 0 

A1100 Pondasi Strauss pile 8-Sep-13 21-Sep-13 0 

A1110 Pondasi P1 ( 110 x 120 x 40) 8-Sep-13 21-Sep-13 0 

A1120 Pondasi P2 ( 110 x 120 x 60 ) 8-Sep-13 21-Sep-13 0 

A1130 Pondasi P3 ( 135 x 150 x 35 ) 15-Sep-13 21-Sep-13 0 

A1140 Pondasi P3A ( 120 x 120 x 30 ) 15-Sep-13 5-Oct-13 0 

A1150 Pondasi Batu Kali ( R. ATM ) 29-Sep-13 5-Oct-13 0 

A1160 Pondasi Tangga 22-Sep-13 28-Sep-13 0 

A1170 Sloof S1  ( 60 x 30 ) lantai satu 22-Sep-13 28-Sep-13 0 

A1180 Sloof S1A  ( 60 x 35 ) lantai satu 22-Sep-13 28-Sep-13 0 

A1190 Sloof S2  ( 50 x 30 ) lantai satu 22-Sep-13 28-Sep-13 0 

A1200 Sloof S3  ( 30 x 15 ) lantai satu tahap satu 22-Sep-13 28-Sep-13 0 

A1220 Sloof Praktis ( 15 x 25 ) lantai satu 29-Sep-13 5-Oct-13 0 

A1230 Kolom K1 ( 50 x 50 ) lantai satu 6-Oct-13 19-Oct-13 0 
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ID Pekerjaan Kegiatan 
Mulai Akhir Float 

A1240 Kolom K2 ( 60 x 25 ) lantai satu 6-Oct-13 19-Oct-13 0 

A1250 Kolom K3 ( 50 x 25 ) lantai satu 6-Oct-13 19-Oct-13 0 

A1290 Dinding Retainning Wall T = 15 cm lantai satu 6-Oct-13 19-Oct-13 0 

A1300 Plat Lantai satu tahap satu 29-Sep-13 5-Oct-13 0 

A1320 Kolom K1A ( 50 x 50 ) lantai dua 17-Nov-13 23-Nov-13 0 

A1330 Kolom K2A ( 60 x 25 ) lantai dua 17-Nov-13 23-Nov-13 0 

A1340 Kolom K3A ( 50 x 25 ) lantai dua 17-Nov-13 23-Nov-13 0 

A1360 Balok B1 ( 60 x 30 ) lantai dua 27-Oct-13 16-Nov-13 0 

A1370 Balok B1A ( 60 x 35 ) lantai dua 27-Oct-13 16-Nov-13 0 

A1380 Balok B2 ( 40 x 25 ) lantai dua 27-Oct-13 16-Nov-13 0 

A1390 Balok B3 ( 35 x 20 ) lantai dua 3-Nov-13 16-Nov-13 0 

A1400 Balok B4 ( 30 x 15 ) lantai dua 3-Nov-13 16-Nov-13 0 

A1410 Balok C1 ( 40 x 20 ) lantai dua 27-Oct-13 16-Nov-13 0 

A1420 Balok BJ ( 80 x 8 ) lantai dua 3-Nov-13 16-Nov-13 0 

A1430 Plat Lantai dua 27-Oct-13 16-Nov-13 0 

A1450 Kolom K1B ( 40 x 40 ) lantai tiga 22-Dec-13 28-Dec-13 0 

A1460 Kolom K2B ( 60 x 25 ) lantai tiga 22-Dec-13 28-Dec-13 0 

A1470 Kolom K3A ( 50 x 25 ) lantai tiga 22-Dec-13 28-Dec-13 0 

A1480 Balok B1 ( 60 x 30 ) lantai tiga 24-Nov-13 21-Dec-13 0 

A1490 Balok B1A ( 60 x 35 ) lantai tiga 24-Nov-13 21-Dec-13 0 

A1500 Balok B2 ( 40 x 25 ) lantai tiga 24-Nov-13 21-Dec-13 0 

A1510 Balok B3 ( 35 x 20 ) lantai tiga 24-Nov-13 21-Dec-13 0 

A1520 Balok B4 ( 30 x 15 ) lantai tiga 24-Nov-13 21-Dec-13 0 

A1530 Balok C1 ( 40 x 20 ) lantai tiga 24-Nov-13 21-Dec-13 0 

A1540 Balok BJ ( 80 x 8 ) lantai tiga 24-Nov-13 21-Dec-13 0 

A1550 Plat Lantai tiga 1-Nov-13 21-Dec-13 0 

A1560 Tangga Monyet lantai tiga 16-Mar-14 22-Mar-14 0 

A1580 Kolom K5C ( 25 x 25 ) lantai dak 19-Jan-14 25-Jan-14 0 

A1590 Kolom Praktis ( 20 x 20 ) lantai dak 19-Jan-14 25-Jan-14 0 

A1600 Balok RB1 ( 60 x 30 ) lantai dak 29-Dec-13 18-Jan-14 0 

A1610 Balok RB1A ( 60 x 35 ) lantai dak 29-Dec-13 18-Jan-14 0 

A1620 Balok RB2 ( 40 x 25 ) lantai dak 29-Dec-13 18-Jan-14 0 

A1630 Balok RB2A ( 60 x 30 ) lantai dak 29-Dec-13 18-Jan-14 0 

A1640 Balok RB3 ( 35 x 20 ) lantai dak 29-Dec-13 18-Jan-14 0 

A1650 Balok RB4 ( 30 x 15 ) lantai dak 29-Dec-13 18-Jan-14 0 

A1660 Balok C1 ( 40 x 20 ) lantai dak 29-Dec-13 18-Jan-14 0 

A1670 Balok BJ ( 80 x 8 ) lantai dak 29-Dec-13 18-Jan-14 0 
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ID Pekerjaan Kegiatan 
Mulai Akhir Float 

A1680 Pagar luar T = 1 m lantai dak 23-Feb-14 1-Mar-14 0 

A1690 Plat Lantai Daak 29-Dec-13 18-Jan-14 0 

A1710 Atap + Rangka 2-Feb-14 15-Feb-14 0 

Berdasarkan Tabel 4.2, dijelaskan beberapa kegiatan dimana tergolong dalam lintasan 

kritis. Kegiatan-kegiatan kritis ini tidak memiliki float, sehingga kegitan-kegiatan ini yang 

tidak bisa dilakukan penundaan untuk proses leveling. Karena jika kegiatan-kegiatan ini 

ditunda, akan mempengaruhi durasi penyelesaian proyek secara keseluruhan. 

 

4.3.2 Lintasan Non Kritis 

Tabel 4.3 Hasil Lintasan Non Kritis Primavera Project Planner 

ID Pekerjaan Kegiatan Mulai Akhir Float Late Start 

A1210 Sloof S3  (30x15) lantai satu tahap dua 29-Dec-13   4-Jan-14 49 16-Feb-14 

A1260 Kolom Praktis (15x15) lantai satu 22-Dec-13    28-Dec-13 49 9-Feb-14 

A1270 Kolom Praktis (20x20) lantai satu 22-Dec-13   28-Dec-13 49 9-Feb-14 

A1280 Tangga Lantai satu 5-Jan-14   18-Jan-14 49 23-Feb-14 

A1310 Plat Lantai satu tahap dua 29-Dec-13   4-Jan-14 49 16-Feb-14 

A1350 Kolom Praktis (15x15) lantai dua 26-Jan-14   1-Feb-14 49 16-Mar-14 

A1440 Tangga Lantai dua 19-Jan-14   1-Feb-14 49 9-Mar-14 

A1570 Screeding + Waterproofing Coating Lantai tiga 9-Feb-14   15-Feb-14 35 16-Mar-14 

A1700 Screeding + waterproofing Coating Lantai Dak 9-Feb-14   15-Feb-14 35 16-Mar-14 

Berdasarkan Tabel 4.3, dijelaskan beberapa kegiatan dimana tergolong dalam lintasan 

non kritis dimana kegiatan-kegiatan ini memiliki float, yang nantinya kegiatan-kegiatan ini 

yang akan dilakukan penundaan dalam proses leveling. 

 

4.4 Reverse Late Start Pada Kegiatan Non Kritis  

Pada Metode Burgess kegiatan-kegiatan yang berada di lintasan non kritis akan 

dilakukan reverse late start, yaitu menyusun kegiatan sesuai dengan late start paling akhir 

menjadi urutan paling awal. Hal tersebut digunakan pada saat kita akan melakukan penundaan 

setiap kegiatan yang memiliki float, dimana kita memulai penundaan dari kegiatan yang 

memiliki late start paling akhir. Reverse late start kegiatan non kritis dapat dilihat pada Tabel 

4.4. 
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Tabel 4.4 Reverse Late Start Kegiatan Non Kritis 

ID Pekerjaan Kegiatan Mulai Akhir Float Late Start 

A1570 Screeding + Waterproofing Coating Lantai tiga 9-Feb-14 15-Feb-14 35 16-Mar-14 

A1700 Screeding + Waterproofing Coating Lantai Dak 9-Feb-14 15-Feb-14 35 16-Mar-14 

A1350 Kolom Praktis (15x15) lantai dua 26-Jan-14 1-Feb-14 49 16-Mar-14 

A1440 Tangga Lantai dua 19-Jan-14 1-Feb-14 49 9-Mar-14 

A1280 Tangga Lantai satu 5-Jan-14 18-Jan-14 49 23-Feb-14 

A1310 Plat Lantai satu tahap dua 29-Dec-13 4-Jan-14 49 16-Feb-14 

A1210 Sloof S3  (30x15) lantai satu tahap dua  29-Dec-13 4-Jan-14 49 16-Feb-14 

A1270 Kolom Praktis (20x20) lantai satu 22-Dec-13 28-Dec-13 49 9-Feb-14 

A1260 Kolom Praktis (15x15) lantai satu 22-Dec-13 28-Dec-13 49 9-Feb-14 

Berdasarkan Tabel 4.4, dijelaskan urutan kegiatan-kegiatan yang digunakan untuk 

proses leveling. Penggunaan tukang besi hanya berkontribusi pada kegiatan-kegiatan 

pembesian saja, sehingga urutan kegitan yang di-leveling dapat diurut menjadi sebagai berikut 

: KP (15 x 15) lantai 2, tangga lantai 2, tangga lantai 1, plat lantai 1 tahap II, sloof S3 (30 x 15), 

KP1 (20 x 20), dan KP (15 x 15).  

 

4.5 Resources Leveling dengan Metode Burgess 

Perhitungan jumlah kuadrat untuk setiap kegiatan nonkritis dengan menunda kegiatan 

untuk setiap unit waktu sesuai dengan jumlah float kegiatan tersebut. Jumlah kuadrat yang 

minimumlah yang menentukan untuk perhitungan kegiatan selanjutnya. Perhitungan ini 

dilakukan secara berulang – ulang hingga setiap kegiatn nonkritis dengan sistem reverse late 

start telah dianalisis semua. 

 

4.5.1 Perhitungan Jumlah Kuadrat Sebelum Leveling 

Perhitungan jumlah kuadrat sebelum leveling dilakukan dengan penggunaan tukang 

besi per minggu, sehingga hasil proses pemerataan sumber daya akan ditampilkan dalam satuan 

waktu per minggu. Untuk menampilkan hasil alokasi tukang besi di software Primavera 

Project Planner 6.0, dilakukan langkah berikut: 

1. Klik menu Resource Usage Profile  

2. Selanjutnya akan terlihat tampilan seperti pada Gambar 4.23. 
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Gambar 4.23 Resources Usage Profile Sebelum Leveling 

Dari hasil resources usage profile software Primavera Project Planner 6.0, didapat 

alokasi tukang besi sebelum leveling dapat dilihat pada Tabel 4.5. 

Tabel 4.5 Alokasi Tukang Besi Sebelum Leveling 

Minggu ke- 

5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 

Jumlah Tukang Besi 

5 10 10 10 10 10 10 6 10 10 5 5 5 5 5 5 5 5 1 - - 

Dari tabel di atas, perhitungan jumlah kuadrat untuk tukang besi sebelum leveling adalah 

sebagai berikut: 

Z0 =52+102+102+102+102+102+102+62+102+102+52+52+52+52+52+52+52+52+12 = 1062 

 

4.5.2 Perhitungan Jumlah Kuadrat Setelah Leveling 

Perhitungan jumlah kuadrat setelah leveling dilakukan setelah setiap kegiatan ditunda 

waktu mulainya sesuai dengan jumlah float yang ada, sesuai urutan reverse late pada kegiatan 

non kritis. Berikut ini adalah contoh perhitungan jumlah kuadrat pada kegiatan non kritis 

setelah dilakukan penundaan: 
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1. Kegiatan pembesian kolom praktis (15x15) lantai dua dengan float 49 hari (A1350).  

Setelah dilakukan penundaan kegiatan pembesian kolom praktis (15x15) lantai dua 

pada software Primavera Project Planner 6.0, hasil resources usage profile dapat 

dilihat pada Gambar 4.24. 

 
Gambar 4.24 Resources Usage Profile Setelah Leveling Kegiatan Kolom Praktis (15x15) 

Lantai Dua 

Dari gambar diatas, hasil  alokasi tukang besi yang baru dapat dilihat pada Tabel 4.6. 

Tabel 4.6 Alokasi Tukang Besi Setelah Leveling Kegiatan Kolom Praktis (15x15) Lantai Dua 

Minggu ke- 

5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 

Jumlah Tukang Besi 

5 10 10 10 10 10 10 6 10 10 5 5 5 5 5 5 5 5 1 - - 

Dari tabel di atas, perhitungan jumlah kuadrat untuk tukang besi pada kegiatan 

pembesian kolom praktis (15x15) lantai dua adalah sebagai berikut: 

Z1 =52+102+102+102+102+102+102+62+102+102+52+52+52+52+52+52+52+52+12= 1062. 

Setelah dilakukan penundaan selama 1-49 hari dari float yang ada pada pekerjaan ini, 

nilai Z1 sama dengan nilai Z0, sehingga tidak mempengaruhi pemerataan sumber daya 

yang ada. 

 

 

 



44 

 

 

 

2. Kegiatan pembesian tangga lantai dua dengan float 49 hari (A1440). 

Setelah dilakukan penundaan kegiatan pembesian tangga lantai dua pada software 

Primavera Project Planner 6.0, hasil resources usage profile dapat dilihat pada 

Gambar 4.25. 

 
Gambar 4.25 Resources Usage Profile Setelah Leveling Kegiatan Tangga Lantai Dua  

Dari gambar diatas, hasil  alokasi tukang besi yang baru dapat dilihat pada Tabel 4.6. 

Tabel 4.7 Alokasi Tukang Besi Setelah Leveling Kegiatan Tangga Lantai Dua 

Minggu ke- 

5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 

Jumlah Tukang Besi 

5 10 10 10 10 10 10 6 10 10 5 5 5 5 5 5 5 5 1 - - 

Dari tabel di atas, perhitungan jumlah kuadrat untuk tukang besi pada kegiatan 

pembesian tangga lantai dua adalah sebagai berikut: 

Z2= 52+102+102+102+102+102+102+62+102+102+52+52+52+52+52+52+52+52+12= 1062. 

Setelah dilakukan penundaan selama 1-49 hari dari float yang ada pada pekerjaan ini, 

nilai Z2 sama dengan nilai Z0, sehingga tidak mempengaruhi pemerataan sumber daya 

yang ada. 
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3. Kegiatan pembesian tangga lantai satu dengan float 49 hari (A1280). 

Setelah dilakukan penundaan kegiatan pembesian tangga lantai satu pada software 

Primavera Project Planner 6.0, hasil resources usage profile dapat dilihat pada 

Gambar 4.26. 

Gambar 4.26 Resources Usage Profile Setelah Leveling Kegiatan Pembesian Tangga Lantai Satu 

Dari gambar diatas, hasil  alokasi tukang besi yang baru dapat dilihat pada Tabel 4.8. 

Tabel 4.8 Alokasi Tukang Besi Setelah Leveling Kegiatan Tangga Lantai Satu 

Minggu ke- 

5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 

Jumlah Tukang Besi 

5 10 10 10 10 10 10 6 10 10 5 5 5 5 5 5 4 4 1 1 1 

Dari tabel di atas, perhitungan jumlah kuadrat untuk tukang besi pada kegiatan 

pembesian tangga lantai satu adalah sebagai berikut: 

Z3 =52+102+102+102+102+102+102+62+102+102+52+52+52+52+52+52+42+42+12+12+12 

       = 1046. 

Setelah dilakukan penundaan selama 21-27 hari dari float yang ada pada pekerjaan ini, 

nilai Z3 lebih kecil dari nilai Z0. Sehingga akan didapat resource scheduling yang baru 

untuk mendapatkan pemerataan sumber daya. 
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4. Kegiatan pembesian plat lantai satu tahap dua dengan float 49 hari (A1310). 

Setelah dilakukan penundaan kegiatan pembesian plat lantai satu tahap dua pada 

software Primavera Project Planner 6.0, hasil resources usage profile dapat dilihat 

pada Gambar 4.27. 

 
Gambar 4.27 Resources Usage Profile Setelah Leveling Kegiatan Pembesian Plat Lantai Satu Tahap 

Dua 

Dari gambar diatas, hasil  alokasi tukang besi yang baru dapat dilihat pada Tabel 4.9. 

Tabel 4.9 Alokasi Tukang Besi Setelah Leveling Kegiatan Plat Lantai Satu Tahap Dua 

Minggu ke- 

5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 

Jumlah Tukang Besi 

5 10 10 10 10 10 10 6 10 10 5 5 5 5 5 4 4 4 1 1 1 1 

 

Dari tabel di atas, perhitungan jumlah kuadrat untuk tukang besi pada kegiatan 

pembesian plat lantai satu tahap dua adalah sebagai berikut: 

Z4  =52+102+102+102+102+102+102+62+102+102+52+52+52+52+52+42+42+42+12+12+12 

+12=1038 

Setelah dilakukan penundaan selama 28-34 hari dari float yang ada pada pekerjaan ini, 

nilai Z4 lebih kecil dari nilai Z0. Sehingga akan didapat resource scheduling yang baru 

untuk mendapatkan pemerataan sumber daya. 
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5. Kegiatan pembesian sloof S3 (30x15) lantai satu tahap dua dengan float 49 hari 

(A1210).  

Setelah dilakukan penundaan kegiatan pembesian sloof S3 (30x15) lantai satu tahap 

dua pada software Primavera Project Planner 6.0, hasil resources usage profile dapat 

dilihat pada Gambar 4.28. 

 
Gambar 4.28 Resources Usage Profile Setelah Leveling Kegiatan Pembesian Sloof S3 (30x15) 

Lantai Satu Tahap Dua 

Dari gambar diatas, hasil  alokasi tukang besi yang baru dapat dilihat pada Tabel 4.10. 

Tabel 4.10 Alokasi Tukang Besi Setelah Leveling Kegiatan sloof S3 (30x15) Lantai Satu Tahap Dua 

Minggu ke- 

5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 

Jumlah Tukang Besi 

5 10 10 10 10 10 10 6 10 10 5 5 5 5 5 4 4 4 1 1 1 1 

 

Dari tabel di atas, perhitungan jumlah kuadrat untuk tukang besi pada kegiatan 

pembesian sloof S3 (30x15) lantai satu tahap dua adalah sebagai berikut: 

Z5  =52+102+102+102+102+102+102+62+102+102+52+52+52+52+52+42+42+42+12+12+12 

+12=1038 

Setelah dilakukan penundaan selama 28-34 hari dari float yang ada pada pekerjaan ini, 

nilai Z5 lebih kecil dari nilai Z0. Sehingga akan didapat resource scheduling yang baru 

untuk mendapatkan pemerataan sumber daya. 
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6. Kegiatan pembesian kolom praktis (20x20) lantai satu dengan float 49 hari (A1270). 

Setelah dilakukan penundaan kegiatan pembesian kolom praktis (20x20) lantai satu 

pada software Primavera Project Planner 6.0, hasil resources usage profile dapat 

dilihat pada Gambar 4.29. 

 

Gambar 4.29 Resources Usage Profile Setelah Leveling Kegiatan Pembesian Kolom Praktis 

(20x20) Lantai Satu 

Dari gambar diatas, hasil  alokasi tukang besi yang baru dapat dilihat pada Tabel 4.11. 

Tabel 4.11 Alokasi Tukang Besi Setelah Leveling Kegiatan Kolom Praktis (20x20) Lantai Satu 

Minggu ke- 

5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 

Jumlah Tukang Besi 

5 10 10 10 10 10 10 6 10 10 5 5 5 5 4 4 5 5 1 1 1 

Dari tabel di atas, perhitungan jumlah kuadrat untuk tukang besi pada kegiatan 

pembesian kolom praktis (20x20) lantai satu adalah sebagai berikut: 

Z6 =52+102+102+102+102+102+102+62+102+102+52+52+52+52+42+42+52+52+12+12+12 

    = 1046 

Setelah dilakukan penundaan selama 35-41 hari dari float yang ada pada pekerjaan ini, 

nilai Z6 lebih kecil dari nilai Z0. Sehingga akan didapat resource scheduling yang baru 

untuk mendapatkan pemerataan sumber daya. 
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7. Kegiatan pembesian kolom praktis (15x15) lantai satu dengan float 49 hari (A1260). 

Setelah dilakukan penundaan kegiatan pembesian kolom praktis (15x15) lantai satu 

pada software Primavera Project Planner 6.0, hasil resources usage profile dapat 

dilihat pada Gambar 4.30. 

 

Gambar 4.30 Resources Usage Profile Setelah Leveling Kegiatan Pembesian Kolom Praktis 

(15x15) Lantai Satu 

Dari gambar diatas, hasil  alokasi tukang besi yang baru dapat dilihat pada Tabel 4.12. 

Tabel 4.12 Alokasi Tukang Besi Setelah Leveling Kegiatan Kolom Praktis (15x15) Lantai Satu 

Minggu ke- 

5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 

Jumlah Tukang Besi 

5 10 10 10 10 10 10 6 10 10 5 5 5 5 3 4 5 5 1 1 1 1 

Dari tabel di atas, perhitungan jumlah kuadrat untuk tukang besi pada kegiatan 

pembesian kolom praktis (15x15) lantai satu adalah sebagai berikut: 

Z7  =52+102+102+102+102+102+102+62+102+102+52+52+52+52+32+42+52+52+12+12+12 

+12=1040 

Setelah dilakukan penundaan selama 39-41 hari dari float yang ada pada pekerjaan ini, 

nilai Z7 lebih kecil dari nilai Z0. Sehingga akan didapat resource scheduling yang baru 

untuk mendapatkan pemerataan sumber daya. 

Untuk perhitungan jumlah kuadrat lebih lengkapnya dapat dilihat pada Lampiran 3. 
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8. Kegiatan pembesian pada seluruh kegiatan non kritis. 

Setelah dilakukan penundaan pada seluruh kegiatan non kritis pada software Primavera 

Project Planner 6.0, hasil resources usage profile dapat dilihat pada Gambar 4.30. 

 

Gambar 4.31 Resources Usage Profile Setelah Leveling 

Dari gambar diatas, hasil  alokasi tukang besi yang baru dapat dilihat pada Tabel 4.12. 

Tabel 4.12 Alokasi Tukang Besi Setelah Leveling Pada Seluruh Kegiatan Non Kritis 

Minggu ke- 

5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 

Jumlah Tukang Besi 

5 10 10 10 10 10 10 6 10 10 5 5 5 5 4 4 4 4 1 1 1 1 1 

 

Dari tabel di atas, perhitungan jumlah kuadrat untuk tukang besi pada penundaan 

seluruh kegiatan non kritis adalah sebagai berikut: 

Z8  =52+102+102+102+102+102+102+62+102+102+52+52+52+52+42+42+42+42+12+12+12 

+12+12 =1030 

Setelah dilakukan penundaan 0 hari pada kegiatan kolom praktis (15x15) lantai satu, 

14 hari pada kegiatan sloof S3 (30x15) lantai satu tahap dua, 35 hari pada kegiatan 

kolom praktis (20x20) lantai satu, 35 hari pada kegiatan plat lantai satu tahap dua, 35 

hari pada kegiatan tangga lantai satu, 35 hari pada kegiatan tangga lantai dua, dan 42 

hari pada kegiatan kolom praktis (15x15) lantai dua, nilai Z8 lebih kecil dari nilai Z0. 

Sehingga akan didapat alokasi yang baru untuk mendapatkan pemerataan sumber daya. 
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4.5.3 Perbandingan Jumlah Kuadrat Sebelum dan Setelah Leveling 

Perbandingan Jumlah Kuadrat Sebelum dan Setelah Leveling dilihat pada Tabel 4.13. 

Tabel 4.13 Perbandingan Alokasi Tukang Besi Sebelum dan Setelah Leveling 

Minggu ke- 

5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 

Sebelum Leveling 

Jumlah Tukang Besi 

5 10 10 10 10 10 10 6 10 10 5 5 5 5 5 5 5 5 1 - - - - 

Setelah Leveling 

Jumlah Tukang Besi 

5 10 10 10 10 10 10 6 10 10 5 5 5 5 4 4 4 4 1 1 1 1 1 

Dari tabel di atas dapat dilihat setelah leveling, alokasi tukang besi sebanyak 5 orang 

pada minggu ke 19 sampai minggu ke 22  akan berubah menjadi 4 orang, 1 orang yang tersisa 

dialokasikan pada minggu ke 24 sampai minggu ke 27. Untuk hasil plotting dapat dilihat pada 

Gambar 4.32. 

 

Gambar 4.32 Alokasi Tukang Besi Sebelum dan Sesudah Leveling 

Berdasarkan grafik pada Gambar 4.26, dapat dilihat setelah leveling, alokasi tukang 

besi sebanyak 5 orang pada minggu ke 19 sampai minggu ke 22  akan berubah menjadi 4 orang, 

1 orang yang tersisa dialokasikan pada minggu ke 24 sampai minggu ke 27. 

 

4.5.4 Hasil Resources Leveling dengan Metode Burgess 

Dari perhitungan di atas diperoleh jumlah kuadrat awal atau nilai Z0 adalah 1062. 

Setelah dilakukan penundaan pada setiap kegiatan non kritis sesuai dengan jumlah float yang 

ada, diperoleh jumlah kuadrat terkecil atau Zmin adalah 1030. Perhitungan lengkap nilai Z untuk 

setiap kegiatan setelah dilakukan penundaan dapat dilihat pada Lampiran 3. Untuk melihat 

hasil penjadwalan setelah leveling menggunakan software Primavera Project Planner 6.0 lebih 

lengkapnya dapat dilihat pada Lampiran 4. 
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